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InSAR in a Nutshell

Theory, Data Access and Data Processing

Sabrina Metzger
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Motivation

Interferometric Synthetic Aperture Radar

• observe changes of the Earth’s shape in high sensitivity
• rapid, high-resolution monitoring tool of remote areas
• “for free” (open-data, free software)

BUT data processing and interpretation is complex

⇒ Let’s take a first step together!

Do these fringes highlight
volcanic deformation or atmosphere?

(Massonnet et al., 1995)
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Radar, SAR & InSAR Acquisition geometry Reflection parameters

Radar – Radio Detection and Ranging
Concept

Radar altimetry concept (Rees, 2010)

• Antenna on satellite carrier emits
and receives microwave very short
pulses

• spherical pulse front, reflected on
surface

• micro waves travel with light speed
(300 000 km/s)

+ pulses penetrate clouds; no
daylight needed

- pulses are delayed by air pressure
and humidity changes
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Radar, SAR & InSAR Acquisition geometry Reflection parameters

Synthetic Aperture Radar (SAR)

Top: radar, bottom: SAR (Massonnet & Feigl, 1998)

Synthetic Aperture means

1 radar pulse compression

2 using Doppler effects

⇒ spatial data resolution is increased by
500-1000 (from km to m)!

(This has the same effect as using a 1000 x
larger radar antenna!)

Radar antenna (10x1.3m), (Photo: ESA)
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Radar, SAR & InSAR Acquisition geometry Reflection parameters

Interferometry – Range change before/after event
radar satellite Sentinel-1
(credit: ESA)
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• Comparison of two data
acquisitions with a time lag

• Phase difference δφ reveals
deformation as function of time

Caveats:

• sensitive only along line-of-sight

• δφ is ambiguous and must be
“unwrapped”

• interferogram represents
topography, atmospheric condition
and ground motion

• precipitation (snow, rain) and
vegetation cause temporal
decorrelation

y1 = |y1|e
iφ1 and y2 = |y2|e

iφ2 are the
complex return signals from of SAR acquisi-
tions. The interferometric phase difference
is given by the complex multiplication,

yintf = |y1||y2|e
i( φ1 − φ2 )
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Radar, SAR & InSAR Acquisition geometry Reflection parameters

Radar coordinate system
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Hanssen (2001)

• The radar antenna is
right-looking

⇒ Signals perpendicular to look
direction remain undetected!

• SAR coordinate system is
defined by

• orbit flight direction ∼ 10◦N
• look angle ∼ 30◦
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Radar, SAR & InSAR Acquisition geometry Reflection parameters

SAR intensity image
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perfect scatterer ("cat-eye")

Good back-scattering objects appear
bright and dominate the respective pixel
value, poor scatterers dark. InSAR works
only with good (and stable!) scatterers.
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Radar, SAR & InSAR Acquisition geometry Reflection parameters

What are good scatterers?
Stable, edgy objects (in green) provide a high interferometric signal quality

landslide fields churches construction site

cars glacier, mountains rock falls rock glaciers, riverbeds

snow / rivers trains lava flows forests / lakes

(photos: flickr cc)
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Radar, SAR & InSAR Acquisition geometry Reflection parameters

Coherence – Measure of “cell stability”

Coherence map Interferometric phase

The coherence is an interferometric quality measure. Stable objects on the ground provide a
high coherence. This is a prerequisite for correct unwrapping.
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Processing Flow Unwrapping Atmospheric signal

From SAR to InSAR
Main processing steps

1 Coregistration: Perfect alignment (sub-pixel accuracy!) of before- and
after-SAR image

2 Interferometry: Calculate phase difference for each pixel

3 Topographic signal removal using a digital elevation model

4 Subsampling (“multi-looking”): Noise suppression and size reduction

5 Filtering: Further noise suppression, e.g. using adaptive phase filter

6 Unwrapping: “Uncoil” the signal and eliminate ambiguity

7 Geocoding: Coordinate transformation into WGS1984, UTM etc.
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Processing Flow Unwrapping Atmospheric signal

Processing example

random phases of two SAR
images

Raw interferogram

After DEM removal

After filtering

After unwrapping
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Processing Flow Unwrapping Atmospheric signal

Phase unwrapping

• unfiltered interferogram • filtered interferogram
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• The interferometric signal is “wrapped”, similar to
contour lines in elevation plots

• One “fringe” (phase cycle) corresponds to half a
wavelength (λ/2) range change (Sentinel-1: λ = 5.6cm)

⇒ Signal must be “unwrapped” to obtain the full
amount of displacement, i.e. shift neighboring
points by a multitude of 2π.
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Processing Flow Unwrapping Atmospheric signal

Unwrapping error examples
Block-like color chunks, elevated by N·2π

S. Metzger InSAR In A Nutshell September 24, 2020 13 / 25



Intro Data Collection Processing steps Data Interpretation Conclusions Data Access References

Processing Flow Unwrapping Atmospheric signal

Atmospheric delay signal
1-day interferogram of Los Angeles (US)

• no surface displacement
expected, but

• atmospheric signal (mm to
cm), depending of

1 topography
2 water vapour/air pressure

• mitigate atmospheric impact
using weather models

Li et al., 2006
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Interpretation Example
Identify ground motion signals
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Interpretation Example
Identify ground motion signals
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Take-home messages

• Interferometric phase differences of before/after-event radar image pairs
show changes of the Earth’s surface in multitudes of half a wavelength
(Sentinel-1: 2.8 cm per fringe)

• These observations are one-dimensional and in range direction
(“line-of-sight”) of the radar satellite only

• Prerequesites are stable back-scatter conditions on the ground; snow and
vegetation cause data decorrelation. Coherence measures the data quality.

• Interferograms also mirror atmospheric conditions (water vapor, air
pressure) and the topography leading to false interpretation. These
impacts are mitigated using weather and elevation models or time-series
analysis.

• Today, many radar data are freely available (e.g. ESA Sentinel-1) and can
be processed “at home”...
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A) Pre-processed interferograms B) Raw data C) Time-series analysis

...therefore, start working with InSAR data!

A) Interferogram interpretation: Download pre-processed interferograms
from the LiCSAR-server as geotiffs and feed them into your ArcGIS/GEarth!

B) Interferogram formation: Process your own interferogram from raw data
using the open-source ESA Sentinel-1 toolbox!

C) Time-series analysis: Calculate your own InSAR time-series within one
day! (Prerequisites: modern laptop, decent internet speed, 20GB disk
space)
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A) Pre-processed interferograms B) Raw data C) Time-series analysis

A) LiCSAR interferogram server
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A) Pre-processed interferograms B) Raw data C) Time-series analysis

A) Download of interferograms, coherence and height maps

“png”: thumbnails; “cc”: coherence;
“diff”: ifg before unwrapping; unw:
ifg after unwrapping

“interferogram“:
interferograms sor-
ted by date1 date2;
“metadata”: height
and coordinate
information
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A) Pre-processed interferograms B) Raw data C) Time-series analysis

A) Visualisation in Google Earth
Freely available sources: ifg – LiCSAR; faults – CA Fault Database; earthquake kml – USGS

NB: LiCSAR interferograms are unwrapped automatically and thus contain
unwrapping errors, looking like big color jumps!
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A) Pre-processed interferograms B) Raw data C) Time-series analysis

B) Sentinel SAR raw data
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A) Pre-processed interferograms B) Raw data C) Time-series analysis

B) Calculate your own interferogram

1 Install the ESA Sentinel-1 Toolbox on your computer [Link]

2 Create a user account on the ESA Open Data Hub. ([Link] The data can
be downloaded here at the Alaska facilities (better for old data!), or
directly in the toolbox.)
Mandatory filter parameters are:

• Mission: Sentinel-1 A or B
• File type: SLC
• Beam mode: IW (Interferometric Wide Swath)
• Before/after scene must be of the same relative orbit number and

polarization!

3 Follow the Toolbox Manual on how to process data [Link]

4 Find additional help on the ESA webpage an the forum [Link]

5 The fastest way is to first load zipped SLC data (File → Open Product)
and then use a pre-defined processing chain that automatically performs all
processing steps (Tools →GraphBuilder → File → Load Graph →

TOPSAR Coreg Interferogram ML.xml), after you have filled in all
processing parameters and hit the “Run” button.
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A) Pre-processed interferograms B) Raw data C) Time-series analysis

C) Process your own time-series
The software automatically downloads pre-processed interferograms and
performs a time-series analysis. Output format are geotifs. This approach is
most suited for small-signals like subsidence and very fast.

• Install LiCSBAS-Software [Link]

• Follow LiCSBAS Manual

S. Metzger InSAR In A Nutshell September 24, 2020 23 / 25

https://github.com/yumorishita/LiCSBAS


Intro Data Collection Processing steps Data Interpretation Conclusions Data Access References

Literature

• Massonnet, D. and Feigl, K. L. (1998), Radar Interferometry and its
application to changes in the earth’s surface, Reviews of Geophysics, 36,
441-500 [Link]

• Hanssen, R. (2001), Radar Interferometry: Data and Error analysis, Kluwer
academic publishers, ISBN 0-7923-6945-9 – 100+ EUR, very thorough

• ESA (2007): InSAR Principles: Guidelines for SAR Interferometry
Processing and Interpretation (ESA TM-19) [Link]

• Uni Alaska, F. A. Meyer, open lecture material on SAR/InSAR [Link]

• UNAVCO, InSAR Course Materials [Link]

• Lu, Z. and Dzurisin, D. (2014), InSAR Imaging of Aleutian Volcanoes:
Monitoring a Volcanic Arc from Space, Springer Praxis Books, ISBN
978-3642003479

S. Metzger InSAR In A Nutshell September 24, 2020 24 / 25

https://agupubs.onlinelibrary.wiley.com/doi/10.1029/97RG03139
https://www.esa.int/About_Us/ESA_Publications/InSAR_Principles_Guidelines_for_SAR_Interferometry_Processing_and_Interpretation_br_ESA_TM-19
https://radar.community.uaf.edu/
https://www.unavco.org/education/professional-development/short-courses/course-materials/insar/insar.html


Intro Data Collection Processing steps Data Interpretation Conclusions Data Access References

Free SAR processing software

Data access

• ESA Scihub (Rolling Sentinel archive) [Link]

• ASF Hub (Full Sentinel archive, including older scenes) [Link]

• COMET-LiCS InSAR portal (pre-processed Sentinel-1 interferograms) [Link]

• Geohazard Exploitation Platform TEP [Link]

Interferogram formation

• STEP – Sentinel-1 tool box [Link] [Tutorial]

• GMTSAR – command line, GMT library [Link]

• ISCE – command line [Link]

• GAMMA – (at some costs!) command line, high-quality software [Link]

Time-series analysis

• LiCSBAS – command line [Link] [Tutorial]

• pyRATE – in python [Link]

• StaMPS – Matlab (Octave?) library [Link]
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